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Update Info 2007.2

1 General

This Update Info for the NAPA Release 2007.2 is a summary of the new features and improvements that have been
made to the NAPA system since the last major release 2007.1.

A list of corrected errors is presented in the last chapter of this Update Info.

The NAPA executable file is named napa072.exe. All executable versions of NAPA must be accompanied with a
compatible version of the NAPADB. The file napadb072.db is to be used together with napa072.exe.

2 Operating system versions

The following operating system versions are currently supported:

Windows:

■ Windows 2000 Professional + minimum of Service Pack 4 with Exceed 8.0.0 (*
■ Windows XP Professional + minimum of Service Pack 1 (** with Exceed 8.0.0 (*

SUN:

■ Solaris 8.0

NOTE!!! NAPA release 2008.2 will be the last NAPA version supporting SUN (Solaris 8.0). After that only
Windows versions are supported.

(* The latest update for Exceed 8.0.0 can be obtained by navigating to:

http://www.hummingbird.com/hummingbirdupdate/index.html

The patches deal with minor issues. The updates are cumulative which means that only the latest one needs to be
installed. However, according to Hummingbird there is no need to apply the patch if you do not encounter any problems
with Exceed.

(** Microsoft virtual machine (Microsoft VM) is included as a part of Windows XP SP1. NAPA Online Manuals use
the Microsoft VM for the search function.

2.1 Situation with Windows Vista and NAPA

Napa has made some successful tests with Windows Vista and it has also been in every day use. Based on these rather
limited testing made so far, there are no known issues with NAPA that would prevent using it.

However, there has not been enough time to gather enough experience and to do thorough testing. Hummingbird made
a statement that Exceed 8.0 is not compatible with Vista. Because we have not made full scale tests with Vista yet, we
do not recommend running NAPA on Vista and we therefore cannot support using Vista yet.
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3 Exceed version

The officially supported Exceed version for Release 2007.2 is Exceed 8.0. NAPA is basically compatible with the
newer versions of Exceed, for example, Exceed 11.0. There are no major improvements to the newer versions of
Exceed and there is therefore no need to upgrade to a newer version. Exceed 11.0 cannot be officially supported due to
the following known issues:

■ Memory leak. Exceed 9.0/10.0/11.0 reserves memory cumulatively and if NAPA is kept running constantly for a
long period of time, all memory will eventually be reserved. This is not a serious problem if NAPA + Exceed is shut
down a couple of times per week as the reserved memory is then released.

■ Scandinavian characters. The Scandinavian characters are not available with Exceed 11.0.
■ In addition to previos ones, there are several other known problems with Exceed 12 & 13 (2007 & 2008).

4 Hardware configuration for computers running Windows

This is the last release delivered on CD. The installation media, in future releases, will be DVD.

The recommended minimum hardware configuration:

■ Processor: Any 64-bit
■ Memory: 1 Gb for Win 2000/XP
■ Disk Space: 60 Gb
■ Graphics Adapter: 128 Mb memory, Open GL compatible
■ Network Adapter is required
■ Screen resolution 1280 x 1024 pixels.

It is, however, possible to run NAPA on a computer with a lower performance. The absolute minimum hardware
requirements would be:

■ Processor: Up from PentiumIII 1000 MHz
■ Memory: 128 Mb for NT4, 256 Mb for 2000/XP
■ Disk Space: 1 Gb
■ Graphics Adapter: 32 Mb memory, Open GL compatible
■ Network Adapter is required
■ Screen resolution 1024 x 768 pixels. It is recommended to start NAPA with Tinylayout if this resolution is used (the

word Tinylayout is entered into the field User Profile in the Login window).

5 User manuals

Updated NAPA user manuals are delivered with the release 2007.2.

The recommended browser for using the manuals is Internet Explorer. Mozilla can be used but it does not show the
search results' highlights correctly.

5.1 Manuals with Windows XP, Service Pack 2

Some problems have been encountered with displaying NAPA Online Manuals if they have been installed on a
Windows XP computer equipped with Service Pack 2. Please check the following settings in order to ensure that the
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Manuals are displayed properly:

1. Internet Explorer settings; check this if Service Pack 2 has been installed.

■ Tools -> Internet Options -> Advanced tab
■ Scroll down to the Security section.
■ Make sure that "Allow active content to run in files on My Computer" is ticked.

2. JAVA support on your computer:

■ Please make sure that the JAVA Runtime Environment is installed on your computer. You can download the
software from www.java.com -> Download

3. Make sure that you have installed the latest browser updates.

Note: it is strictly not recommended to run NAPA system with any operating system version lower than indicated or
without the indicated service packs or patches.

6 License file

6.1 Napalicense

A new NAPALICENSE will not be delivered for this release. The license file delivered for the release 2007.1 is valid
also for the release 2007.2.

7 Installation instructions

The installation instructions for NAPA and Exceed are gathered into one pdf document. Please find the document
Installation_instructions.pdf on the NAPA Release 2007.2 installation CD.
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8 Hull Surface Editor

Release 2007.2 has changes to the keyboard shortcuts that are available in the Hull Surface Editor. Standard graphic's
keyboard shortcuts have been implemented.

1 Zoom window

2 Zoom interactive

3 Interactive projection

4 Realtime projection

x/X X projection

y/Y Y projection

z/Z Z projection

a/A Aft projection

f/F Forward projection

arrow UP Zoom in

arrow DOWN Zoom out

It is most likely that w, s, a, and d keys will also be affected in the future. These things have necessitated the following
changes in the existing keyboard shortcuts:

■ Ctrl+x switches of active curve at node
■ Ctrl+f fairs a point
■ Ctrl+d deletes a point
■ Alt+up/down/left/right arrow will move a point in an X Y or Z projection
■ Alt+up/down arrow will move Z coordinate in an arbitrary projection
■ Alt+left/right arrow will move Y coordinate in an arbitrary projection
■ Left/right arrow will move X coordinate in an arbitrary projection

Holding down the Ctrl key while selecting with the middle mouse button now centers the projection on the selected
point or node.

9 Loading Conditions GUI

■ Updating of the MASS table improved
■ ID, DES and UNIT can be given in notes for Result macro in LD GUI. Use ID=text, DES=text and UNIT=text in the

notes to activate (must be separate lines, and the line must start with ID=, DES= or UNIT=)

10 Stability Criteria

Range end changed from FA to FAUN in criteria AREA40, AREA3040 and IMOWEATHER.
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11 Manager Applications

11.1 PROB

New input is added on top level of the manager. Now the number of passengers is separatred from N1 and N2 (number
of persons). The values for the previous (Rel. 2007.1) N1 will now show up in number of passengers, so be aware of
that the input will change. The number of persons is used in the R value calculation while the number of passengers in
the moment calculation.

The length of the damage in regulation 8.1 shall be the length defined in the International Convention on Load Lines.
The default length used by MGR*PROB is the reference length from the reference system but this can now be replaced
by a user defined input value.

■ Minor damage workaround removed
■ Reg 8.2-3 workaround used DISP, not DSP0 in SFACMOM calculation. This does not affect the results as the

compartments are empty.
■ Penetrations for Reg 8.2-3 adjusted. Interpolated result was slightly less than what the rule asked for.
■ BLIM option check for multi-zone damage generation added
■ Range start removed from Reg 8.1 criteria

11.2 Visibility

■ Unnecessary printout to command window hidden
■ Negative trim sign corrected

11.3 FLOODING_SIMULATION

■ Edit opening macro stopped running in the middle (stepmode)
■ Alternative for stage in edit opening changed from LAST -> FINAL
■ Z-Range in opening plot extended
■ ETIME, T, TR and HEEL are now shown in the animation

11.4 V-lines

An error which might have lead to the wrong calculation of the deck height was corrected.

11.5 Freeboard

■ The height of superstructure is now calculated at side also in the case of rooms.
■ The calculation of height is the minimum of a number of heights exceeding 0.
■ The upper limit in z-direction of the projected area used for reserve buoyancy calculation is taken at side of the

freeboard/superstructure deck.
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12 VARDEF* table - LISTSELECT component

The views where the highlights are shown can now be controlled in the vardef table by assigning HLV=views as

■ UL: upper left
■ LL: lower left
■ UR: upper right
■ LR: lower right
■ ALL: All views

in the options column on the same row as the LISTSELECT.

13 FEM link

13.1 General

Improvements were implemented for idealization of an FE model and for deleting duplicate elements or elements of
zero area resulting from the idealization process. An FE model read from the database will retain its control parameters
(tolerances, priorities, etc) until a relevant FEMDEF table is changed or the command GEN is given.

13.2 Output

Ends of stiffeners can be extended to connecting structure or to a near-lying point depending on the options selected in
the FEMDEF* table. The type of extension is to be selected separately for connected and unconnected stiffeners. It is
now possible to plot unconnected stiffeners with PLOT BU. If also unconnected dummy stiffeners are taken into
account, PLOT DU is to be used. These two options apply also for the command LIST.

The name (STID) of connected structure for stiffeners can be listed by adding NODE1 and NODE2 to LQ FEML, and
giving, for example, the command LIST B. Corresponding nodes can be plotted with PLOT N=NODE1 and
PLOT N=NODE2. It is noted, however, that connection points are not necessarily nodes points of an FE model and in
such a case are not shown in the plot.

It is possible to identify features related to the line segments of an FE-model:

SET NAME=’STID’ or SET NAME=’ID’
ID NAME
PLOT L or PLOT B

STID and ID can also be added to LQ FEML for listing purposes. Also, the offset of a beam element can be listed. The
offset is defined as the distance of the center of gravity of the profile from the mean line of the attached plate. In other
words, half of plate thickness is taken into account. The thickness of the attached plate can be listed by using
LQ FEML PLTH/PLATE.

The name of the FEMDEF* table for objects can be listed by adding FEMDEF to LQ FEM and giving the command
LIS. Options used to create the topology model can be listed correspondingly by giving LQ OPTION.
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13.3 Selection of objects

Objects can be selected with the command SEL also on the basis of STYPE in addition to the name, for example,
SEL STYPE=DECK.

14 NAPA ER

■ Focus stays in tank table after entering a value into the table
■ Unnecessary criteria warning removed, error in if statement when loading condition changed
■ Liftoff calculation loop fixed. It looped if there were a TIDE <>0
■ Liftoff cannot be calculated with a ground defined based on the floating position. Warning added
■ Liftoff calculation tolerance reduced to 2 cm
■ AIRP changes will also open the Upd.Intermediate Results button
■ WID not found error removed in strength tab
■ Unnecessary update for outflown loads when there is only one item in the condition tree removed
■ LOAD model table changed so that the LTYP is changed when the load changes
■ INITIAL value to AIRP in actions list added
■ GROCLR calculation moved to macro for easier use in output macros, not in ER_MW yet
■ Setting deflection to empty in the preferences dialog now also turns it off
■ EPHI renamed in criteria tab plots to AREA
■ HelpText for quantity HM in compartment table modified
■ Sometimes all criteria were not visible in the Crit tab
■ Progress bar added when creating new scenario and saving a scenario
■ Calculation side displayed in Crit tab
■ Draughts reported are corrected for deflection
■ Liftoff also reports penetration (max ZCNT)
■ Strength plot now also plots profile if it exists and is set in the reference system
■ Enforce the criteria group selected in output macro
■ Relative strength values now show the sign
■ Save now implies “apply changes”
■ Environment and filtering of internal openings selections are saved with the condition
■ Criteria tab now also displays the relevant openings within the heel range
■ Default HEEL set by ER if max angle is less than 55 deg is now: HEEL (-70 -30 10) (-25 -10 5) (-7 -1 2) 0 (1 7 2)

(10 25 5) (30 70 10)
■ When a new scenario is made, the preference dialog is automatically opened
■ Sections of the HULL (in LD arguments) are also drawn in the graphics to aid in grounding definitions
■ Criteria are listed to both sides if HEEL range allows it
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15 Grain Stability

15.1 Allowable grain heeling moments & GM > 0.3

The GM > 0.30 m criteria was not included in the allowable grain heeling moment list previously. Now, the program
will output a minus sign (-) where this criteria fails.

If the GM>0.3 criteria is passed but the residual area or the maximum heel criteria fails, the program will display 0.0m.

Note that the free surface effects are not taken into account in the allowable grain heeling moments list, so when the
table is used, a free surface correction to the VCG must be used.

The iteration tolerance for the area criteria when calculating the allowable grain heeling moment has been decreased to
improve accuracy.

15.2 Check command

There was a bug in the GCR?> check [loadingcondition] command which in some cases lets the GM
correction go unnoticed.

When checking the GM criteria, GM was calculated from the GZ curve at 0 degrees heel. Now it is calculated directly
from the hull shape. This might be seen in the decimals.

The check [loadingcondition] command is still taking the GM from the GZ curve, but the method for getting
the GM has been improved, which might lead to very small differences in the results.

15.3 Step discontinuity in the hatch and hold bug

In a case where there was a step discontinuity at the same x-location, in both the hatch and the hold, there was a
problem with the calculation sections around the discontinuity. This has now been fixed.

16 List of corrected errors
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NAPA Release 2007.2
Update Info

List of corrected reported errors and suggestions

The following error corrections and improvement suggestions, have been included in the new release. The ID number refers 
to the action number maintained by the Customer Service at Napa Ltd

173 LD: The mass loads table MASS*WORK (in LD GUI) is updated when replacing an ADDed loading condition with another 
one. 

289 Slack change updates the LD GUI
370 TLIM has been added to the list of arguments available in the LD window
452 When an added loading condition is removed from the current, the load locations not existing in the current arrangement are 

removed.
1159 Reference surfaces of compartments are now shown in the subdivision table. 
2026 Load types H and LH are now handled more correctly in the LD GUI (values displayed in the table)
2613 DR - TODXF: A possibility to transfer NAPA's colors with the RGB code into DXF introduced
3182 Scaling in PLOT +IL command went wrong if the cargo hold had not been plotted before.
3238 Surface representation of rooms improved
3269 Parameters can now be given to criteria / moment macros
3640 NAPA ER now displays the initial AIRP value in the actions tab
3802 LD: Mode step (CR_I) works better in the LD GUI (Criteria tab)
3846 IV quantity now also calculated without G multiplication in SecPro
4150 Calculation of quantities in the superstructures item in the Freeboard Manager has been corrected.
4354 Some restrictions added to the shelf ground definition. It cannot be located outside the ship.
4361 Object info: Date, time and used draught added included in print.
4405 Moment macro for the RINATUG criteria is updated
4417 SM window's room definition editor does not change the room description automatically to UPPER CASE anymore
4553 Marpol Manager: Possibilities to use densities from the arrangement added to reg 12A
4570 Error catcher can now be resized without loosing the clear button
4572 Error catcher output improved
4592 MARPOL Manager: Cdb value to fuel tanks fixed
4595 Void extension to a sloping wingtank surface forward and aft of the hatch failed in some cases.
4634 With some Manager application and a certain sequence of opening and closing items in the tree, some items that should not 

have been visible were visible. This bug is now fixed.
4640 DES LOAD in LD shows now also very small loads
4653 Contract Design Manager -> container arrangement: X start column understands both X coordinates and frame numbers

4687 CR_I: PROF (name,c,name,c,...) command accepts now much longer syntax than earlier
4745 FEM model saving problems fixed
4752 Stability Booklet Manager: Item "Stability Criteria" fixed under "6 Loading Conditions"
4814 Open Project From File... dialog finds also Z: drive
4835 Bottom area calculation of reflected rooms corrected
4836 Plotting of structural arrangement tables containing combined surfaces has been corrected.
4863 Clock fixed
4865 The new lock feature of the Hull Surface Editor in 2007.1 prevented new curves from being selected after they were created. 

This has been fixed.
4869 Due to internal rounding, -90 degrees and 270 degrees were not being treated the same for wind model projected area 

calculations. This resulted in incorrect windage areas at these angles for heel angles of 90 degrees. This has been 
corrected.

4872 File > Change Version... > "Set as Default Version" fixed
4873 When inporting DXF polylines, the bulge feature is now correctly transferred to NAPA
4882 LD GUI: Results tab: ID, DES and UNIT can be given in notes (Text Editor > Edit > Notes...)
4896 Ground definition default length corrected to LREF*10% as in the explanations
4918 Geometry Editor does not delete unused purposes from the PAR*PRO table.
4933 Wind moments from wind models were calculated incorrectly in the azimuth range 180 to 270 degrees.
4934 Quantity FIREINS added to ARR*MODEL table. Used in MGR*INSULATIG
4942 Iteration of floating position in a grounding case now improved.
4960 LOAD command in SecPro has been unified with sp.load()
4969 HYD: In plot of a loading scale, in sea water density correction under the light weight, any ghost lines are not appearing 

anymore.
4970 Contract Design Manager: An error which lead to the incorrect reduction of containers due to visibility was corrected.
4972 The quantity VNET produced 0.0 in the listing for a hold in the filled conditions (F, UT, UTE). This has been corrected.
4973 !ADD DAMCHECK was broken in 2007.1 -> now corrected
4976 The Automatic Backup function of the Hull Surface Editor was not working. This has been fixed.
4980 Deck plate thickness was added twice in the minimum bowheight calculation
4984 FRA: NON BOTH command fixed
4990 ADM: MESSAGE command returned
5006 SIDE quantity added to LIST CRT in CR intact. It displays the side PS/SB to where the criteria calculation was done
5008 ADM: UPD/VER command returned
5027 DR Window: Opening drawings with too long names does not cause problems anymore
5035 Table Editor: File > Export to CSV creates a correct CSV also when a Manager Application is open
5048 ARG GET in DAM now applies the FORCE BOTH argument properly
5064 The volume used for calculating mass and volume of a filled grain load was previously calculated from the grain cargo 

space. In some cases this was inaccurate which lead to FILL no being 100%. Now the volume is calculated from the room in 
the arrangement.
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